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INTRODUCTION 
Congratulations! You have just acquired the portable creasing and folding  
analyzer CREASE CHECKER. This device is the optimum tool to control the conver-
ting process of creasing. It measures the characteristics of the bead, the spine, the 
folding  symmetry and angle in a fast and intuitive manner. The software automati-
cally creates quality control reports.

The CREASE CHECKER software is available in two versions:
•	 CREASE CHECKER PLUS
•	 CREASE CHECKER PREMIUM

CREASE CHECKER PLUS

Contact your dealer to get the proper upgrade code for your device. Insert the 
upgrade codes by selecting the PLUS upgrade function from the Help menu.
In addition there are available optional function modules. These modules require 
the PLUS license.
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CREASING RULE

The CREASING RULE function enables you to measure the characteristics of your 
creasing rules. The function can be accessed only if the CREASING RULE Code is 
inserted. Insert the CREASING RULE code by selecting the Creasing Rule License 
Item from the Help menu.

CREASE CHECKER PREMIUM

The CREASE CHECKER PREMIUM function offers additional job statistics for crease 
and embossing measurements. Also additional crease profi le calculations are 
available with this function module. The function can be accessed only if the CREASE 
CHECKER PREMIUM Code is inserted. Insert the CREASE CHECKER PREMIUM Code 
by selecting the CREASE CHECKER PREMIUM License Item from the Help Menu.

The CREASE CHECKER PREMIUM option is composed of the upgrade code and a 
hardware tool, that helps to keep the measurement sample fl at in case of crease 
measurement or embossing measurement.
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E-GUIDE
 
The E-GUIDE option is composed of a mechanical tool that guides you while pulling 
the CREASE CHECKER over the embossed area. This leads to a repeatable, fast 
and easy 100% control of your embossed area. The function can be accessed only 
if the E-GUIDE Code is inserted. Insert the E-GUIDE code by selecting the E-GUIDE 
License Item from the Help Menu.

E-GUIDE is supplied with the mechanical E-GUIDE Tool.
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POWER BOX
 
The POWER BOX function offers additional job statistics for finished boxes. Insert 
the POWER BOX code by selecting the CREASE CHECKER PREMIUM License Item 
from the Help Menu.

The POWER BOX Option is supplied with a mechanical tool to put and hold in  
position the finished box in an easy and quick manner.

Important: This manual describes the current version of the CREASE CHECKER 
hardware and software. Future enhancements or modifications are reserved.
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SAFETY INSTRUCTIONS
WARNING

For safety reasons it is absolutely necessary to read through the user’s guide and 
all of the instructions it contains.
 

GENERAL SAFETY RULES

If the safety recommendations and instructions in this User Guide are not com-
plied with, measurement errors or data loss or physical injury or property damage 
may result

•	 CREASE CHECKER is not intrinsically safe. Therefore the device cannot be used 
in an environment with explosive vapors where there is a risk of spark ignition.

•	 CREASE CHECKER may not be used in an area with strong electromagnetic 
fields.

•	 Use the CREASE CHECKER in ambient temperatures between 10°C (50° F) and 
40°C (104°F), and do not expose the CREASE CHECKER to direct sun light.

•	 The CREASE CHECKER Sensor should never be opened as there are no user- 
serviceable parts. Doing so voids the guarantee. Contact your authorized  
dealer if repairs are necessary.

•	 To avoid incorrect handling, the CREASE CHECKER should only be used  
by trained personnel.

•	 The CREASE CHECKER should only be used on dry measurement objects.
•	 The CREASE CHECKER should be protected against chemicals, corrosive vapors,  

strong mechanical vibrations and impacts.
•	 Use original spare parts and accessories only.
•	 Use the original packaging exclusively when transporting.
•	 The CREASE CHECKER casing can be cleaned with a dry cloth.
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INSTALLATION
Start your Computer and wait until all boot processes have terminated and your 
computer is ready to operate. Do not plug the USB cable in at this time.

Plug the CREASE CHECKER USB Memory Stick into a free USB Port and wait until 
Windows has recognized and registered the USB Stick as a Mass storage Device.

INSTALL THE CREASE CHECKER SOFTWARE

The USB Memory stick contains a setup utility ‘setup CREASE CHECKER.exe’, 
which can be run to install the CREASE CHECKER Software on your PC.

Before termination the video driver installer will automatically be started. 
Click INSTALL.

Wait until the installation of the driver is finished.

Now connect the USB cable to a free USB2.0 port. Windows will automatically 
detect the driver and assign it to the device.
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RUN THE APPLICATION
 
•	 Launch the CREASE CHECKER.exe,
•	 Click the CREASE CHECKER Icon on your desktop or,
•	 Run the CREASE CHECKER from the Windows Start Menu.

You can use one Software installation for multiply Hardware. Copy the ‘<serialnum-
ber>_CREASE CHECKER.INI’ file from the USB Stick into the Installation directory 
of your computer. If more then one of those files is located at program start, than 
the software will promt for Device selection:

Select a device from the list 
and click the preview Icon.

Click the Cancel Icon to 
maintain the most recently 
used device.

You can always change the connected device by selecting the ‘Select Device’ item 
from the ‘Device’ Menu.
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Measure a new box in 
production quality control.

Measure new embossing-
debossing job (CREASE  
CHECKER PREMIUM only).

Analyze image.

1 	  Captured image for analysis
2 	  Box definition window
3 	  Live Image of camera
4 	  Analysis types and grafical results
5 	  Numerical Results and Report preview

MAIN WINDOW ICONS
MAIN MENU FUNCTIONS

1 2

3 4 5

MAIN WINDOW

Open Statistics on quality 
reports.

Open Standards Database.Load Image.

Save actual image.Measure new finished box  
job (POWER BOX only).
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SETUP STATISTICS AND JOB STATISTICS FUNCTIONS

REFERENCE DATABASE FUNCTIONS

Clear statistics.

Add new Box reference.

Remove most recent 
measurement 
from Statistics.

Remove Box reference  
from Database.

Add most recent measurement and all future measurements to 
statistics automatically and re-calculate average, maximum and 
minimum and Standard Deviation. Click this icon again to stop 
adding measurements to statistics.

Save actual statistical data.

Select Box Layout  
(PLUS Version only).

Copy a reference.

Cancel box data collection.

Open Box Editor  
(PLUS Version only).

Open Box Editor  
(PLUS Version only).

Get a proposal fort he  
brightness settings.

Undo changes and 
close Window.

Accept and save data  
– create PDF report.

Measure references.

Calculate tool dimensions.

CAMERA FUNCTIONS

Preview. Capture.
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CONFIGURE YOUR INSTALLATION
Select Settings from the file menu. Select your language from the Language page.

You can protect additional settings by password. Check or un-check the Password 
protection item on the right bottom. Insert the password <creasing> to make your 
choice permanent.
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The password protection will disable the modifications of all settings. Only the  
language can still be selected. Further the modification of references will be 
disabled by this function.

Select the Additional page and
•	 change between metric system (mm) and Imperial (inch) system.
•	 select the number of significant digits for measurement results.
•	 select the number of beads in case of multi bead measurements.  

If 1 is selected, then the software will automatically detect the number of beads.
•	 select History if the previous measurement should be displayed by a red line  

or the previous measurement is not displayed at all.
•	 Select the mathematical formula for the opening calculation in crease measure-

ment. Narrow opening is an alternative interpretation for the starting and ending 
of a creasing line cross section on the material surface.

•	 Select if a noice filter should be applied to the surface profile curve and how 
strong this filter should be (values 0 = no filter, 10 = very strong filter). The noise 
filter will reduce the impact of surface structure like fibers, print or gloss. Please 
note, that a noise filter always makes the curves smooth and therefore  
eliminates drawing details. It can appear little differences in measurement 
values depending on the filter setting. It is recommended to use filter setting 0  
if very tiny structures should be measured (like cut score lines) . On rough  
surfaces, glossy surfaces or printed surfaces the noice filter can help to improve 
the repeatability of the readings.

•	 Enable and disable measurement functions.
•	 In case the CREASE CHECKER PREMIUM Module is activated there is a separate 

filter setting for crease measurements. In addition the level for the crease  
width measurement can be selected. Insert a value followed by % to specify  
a percentage level. Insert a value without % to specify the level in microns.  
The level is always calculated starting from the bottom of the crease.

•	 In case the E-GUIDE Module is activated there are available settings to optimize 
the embossing measurement.

	 –	 Select the number of images to capture during one single measurement 
		  procedure. The more images are captured, the more details are used  

	 to calculate the average depth but the more time is needed for a single 
		  measurement.
	 –	 Select the size of the measured patch. This is used to display the 3D image 
		  in a proper XY relation. It has no impact on the measurement result.
	 –	 Select the time the traffic light is on hold before the device can be pulled 
		  over the embossing area.
	 –	 Select the Frame Rate for Image Capture.
	 –	 Select if your embossing is very deep (> 0.1mm).
	 –	 Select the depth % to use to calculate the average depth of the 
		  embossed area.
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Select the Reports page.

Load your company Logo that will be applied to your quality reports by clicking the 
File Open Icon. Insert your company details below as they will appear in the header 
of any report. Specify the output format for tab delimited text format output.
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Important : 
in order to save and re-load setup process data the ‘Output Header’ flag needs 
to be checked.

The PLUS version offers in addition the software configuration page.
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Select the file location of the reference database. Type the file name into the proper 
field and confirm by pressing the ENTER key or select the database file by clicking 
the open Icon on the right hand.

Select if the database can be modified or not. Use this flag to prevent the user 
from editing the database in case of multi-user installations accessing the same 
reference database file.

In case the CREASE CHECKER PREMIUM Module is active, also the database file 
for the embossing-debossing references can be selected.

In case the POWER BOX Module is active, also the database file for the finished Box 
references can be selected.

In addition you can select the destination path where all PDF reports should be 
saved. The reports will be saved into sub-directory of the selected path. In case  
the CREASE CHECKER PREMIUM Module is activated, you can save original captured 
images into a sub directory \SetupRep\Img by selecting the Save Image Selector.

Select if the PDF report should be displayed after creation.

Select if during job measurement the next crease type is selected automatically 
after the number of predefined measurement positions have been measured  
for the actual crease type.

The CREASE CHECKER PLUS can run on a network communicating with a server 
application based on two communication protocols: TCP-IP e HOT FOLDER.  
For details check the manual CREASE CHECKER Host Interface.pdf.
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STANDARDS DATABASE
The CREASE CHECKER software offers a database with standards. Click the  
database icon to open the database interface.

You can maintain your own database by adding or removing records from 
the database.

Click the ADD Icon to add a new record. Compile the fields and click OK.

Select the record from the list that you would like to remove from the 
database. Click the delete icon to remove the record from the list.

Select the record from the list you would like to modify. Modify the data and 
click OK.

The Bead and Spine dimensions as well as the 
requirements for the Creasing counterparts dimensions 
differ depending on the direction of the crease and 
fibers of the material. The standard database offers four 
different references (A), (B), (C), and (D) . In case of PLUS 
version there can be used up to 7 different references 
whereby the naming of the references can be selected 
with the box editor (see opposite).

Create a new reference record and copy the data of the selected record 
into the new record.
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The crease of type B are assumed to be perpendicular to the crease of type A.

The orienation of the package can be defined as A being parallel to fibers or A 
being orthogonal to fibers.

•	 Create a new reference by clicking the  Icon.
•	 Insert a new name into the Standard field.
•	 Select the orientation of the A-crease.
•	 Based on material thickness, tool width and fiber orientation you can  

calculate a proposal for the Creasing counterparts specifications for A and B  
by clicking the calculator Icon. If you would like to use other specifications,  
type the new values into the proper edit fields.

Select the camera settings to be used to measure this material:

Position the Device on a typical bead of the target material. Click this icon.  
The Software will automatically test different settings and select the  
best setting for the current material. The selection will be confirmed by a beep.

There are four sets (A), (B), (C), and (D), of references for each record: one for crease 
parallel to fibers and one for crease perpendicular to fibers and two diagonoal 
crease types.

The PLUS version of the CREASE CHECKER Software offers seven sets of  
references per box that can be configured by means of the box editor.

In addition the PLUS version implements the possibility to link a specific  
customized Box Layout to any reference. The basic version offers only one  
standard Box Layout.

Click the Box Layout selection Icon to open the list of available Box Layouts.
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Select a Box Layout by clicking into the graphical display of the proper Box 
Layout. Link the selected Box Layout permanently to the actual selected refence 
by clicking the OK icon.

In case there has not yet been defined a Box layout, you can open the box editor 
by clicking the Box editor Icon. Define a Box Layout and link it to the actual  
reference set as described above.

Reference values can also be defined by measuring samples. Click the 
Measure sample icon of the proper column to start the measurement process. 
Measure the bead of the samples. Finally click OK to permanently save the 
new reference values.

Insert reference numbers and tolerances.

Specify the noise filter for this reference. The nois filter always removes tiny 
details of the measured profile such as there might appear small differences  
in measurement reasults between filter and no filter. It is recommended to use 
a filter on rough surface, glossy surface or surface with print with it is recom-
mended to use no filter (value = 0) in case sharp corners or very small objects 
need to be measured.
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In case the CREASE CHECKER PREMIUM Module is activated there can also be 
inserted references for crease measurement.

In case of crease measurement insert the level of width measurement.

The CREASE CHECKER PREMIUM Module also supports the use of references 
for embossing and de bossing. Select the embossing/debossing page to insert 
references and tolerances.
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The POWER BOX Module enables the Reference database for folded boxes.

Click the ADD Icon to add a new record. Compile the fields and click OK.
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Open the Box Layout Editor by selecting the Box Editor from the Tools menu.

Open an existing Box Layout or import a Box Layout from any JPG File. 
The import will automatically resize the Box Layout for the 3 resolutions 
required by the CREASE CHECKER Software.

As an alternative you can retrieve the source image by selecting it in the 
PDF file, copy it to the Windows clipboard and clicking the past icon 
of the Box editor.

You can also load one of the predefined box layouts from the library by 
clicking the LIB Icon.

In case the source image does not show high contrast edges, the past can 
be performed applying a filter. Select the proper area in the source PDF file, 
copy the image, and click the filtered past Icon.

Reload previously defined box blank layouts by clicking the box blank Icon.

THE BOX LAYOUT EDITOR 
(PLUS VERSION ONLY)
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Select the type of measurement you would like to define measurement locations for.

Continue to click on positions until all [A] measurement locations are set. Now select 
the [B] icon and proceed to define [B] measurement locations. Proceed with [C] and 
[D] accordingly.

Click the clear Icon to clear the layout from any measurement locations 
previously defined.

A preview rectangle will be displayed when moving the mouse arrow over  
the box layout.

Move the preview rectangle over the intended measurement position and click 
the left mouse button to store the new position.
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Remove a single measurement position by selecting the Remove Icon and 
clicking with the left mouse button into the proper position.

Below the Type character there is a selector to select the type of the crease.
•	 Select ‘S’ for standard crease.
•	 Select ‘A’ for auto detection of the number of crease lines in case of multi crease.
•	 2..7 Select the number of creases in case of multi crease.

Save the actual Box definition.

Rename a position by double clicking the proper icon and inserting a new 
name (singel character).

All positions that have already been inserted will be renamed automatically.

Below any crease type icon there can be selected the number of creases 
composing the folging line of the box.
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DEFINE MEASUREMENT LOCATIONS FOR EMBOSSING  
(CREASE CHECKER PREMIUM ONLY)

The reference locations for embossing measurements are inserted the same way  
as you did for crease and bead measurement locations. Select a box blank layout 
and insert A..G locations properly.

Save the layout as Embossing Reference.

Open an existing Embossing Reference.
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DEFINE MEASUREMENT POSITIONS FOR THE FINISHED BOX 
(POWER BOX ONLY)

The reference locations for finished box measurements are inserted the same way 
as you did for crease and bead measurement locations. Select a box layout and 
insert A..G locations properly.

Open an existing folded box layout.

Save the layout as folded box layout.
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TYPICAL PROCEDURE TO DEFINE  
NEW STANDARD 

INITIALIZE THE CAMERA

A flashing left dot shows that the camera is active. A steady right dot 
shows that the key at the device has been pressed, a new image has 
been captured, and the software is analyzing the image.

Select the brightness type (white, gray, black) of the substrate. Use the scroll bare 
to fine tune the brightness. White (or light gray) card board can be analyzed with the 
standard setting shown below.

Open the standards 
library window.

Click Preview to start the Live Image of the camera.

Create a new empty standard.
Insert the standard Identifier.

Create a new Box Layout 
if required by means of the 
Box Editor.

Get a proposal for the 
brightness settings.

Measure reference boxes that 
perform properly on the 
packaging line for any single 
crease type. Insert tolerances.

Save the standard 
permanently into 
the database.

Link the new Box Layout to 
the standard by selecting it 
from the list.

Insert material thickness and 
knife width and calculate the 
tool dimensions.
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Measure bead 
characteristics.

Measure crease 
characteristics.

Measure fine structured 
embossing or de-bossing 
areas as for example text.

Measure subsequently bead 
and crease characteristics 
and overlay images to obtain 
cross section image.

Multi Crease Measurement.

Measure embossing or 
de-bossing areas.

MEASUREMENT FUNCTIONS

EXECUTE A MEASUREMENT

•	 Click Preview in case actually no Live Image is displayed inside the preview window.
•	 Select the measurement function.
•	 Position the device parallel to the crease (bead) to measure such as the crease 

image is centered in relation to the blue guide line overlaid to the PREVIEW image.
•	 Press the button of the device and keep the device in position until the captured 

image appears in the Analysis Window.

The software automatically calculates the dimensions and displays the results  
graphically inside the result window and the numbers in the table window.

Measure embossing using 
E-GUIDE.

Measure the folding characte-
ristics of the finished box.
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Click the OK Icon to create a PDF report of the actual statistics. The report is 
automatically saved and can be printed.

Click the save icon to save all measurement data into a tab delimited text file. 
Important: in order to re-load the data to continue adding readings it is neces-
sary to have checked the option ‘Output Header’ in the settings window. 
Reload the data by clicking the ‘Load measurement data’ Item in the File menu.

Delete most recent measurement from the statistics.

SETUP PROCESS
 
Setup your embosser by measuring various locations of beads and 
collecting the data in a statistic.

When testing in a new box or material, there will not be any pre-defi-
ned standard available. Make sure the proper selector is un-checked.

Clear statistics, start new statistics

Add the first sample measurement to the statistics. All future measurements 
are automatically added to the statistics until this Icon is clicked again.

Measure the first sample.

Once a reference for a card board material or a box blank is available it is still 
necessary to setup the embosser before starting production. In this case check 
the Standard selector to compare actual readings with reference numbers. 
If the current readings are out of tolerance, the numbers will be displayed in red.
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BEAD MEASUREMENTS

The vertical axis (Y) of graphical display is zoomed by a factor displayed in the 
left top corner of the graph (Y:X = 3.4 : 1 in above example). This makes it easy to 
identify minor differences in shape and height of the Bead or Spine.

The optimum bead is drawn as a gray background based on the reference values 
of the active reference. The actual bead curve is displayed in black color. The 
bead width is displayed on top of the window. The bead height is displayed on top 
of the curve. Left and right angle are displayed at the left folding point and right 
folding point respectively. The symmetry is displayed as difference between the 
perpendicular of the maximum height position to the base line and the center of 
the bead.

The previous measurement displays as a red line. The average bead is displayed as 
a blue line.
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CREASE MEASUREMENTS

Crease depth measurements are showing the deformation of the substrate.
The crease with is measured at half depth (50%) as the crease cross section function 
is quite smooth at the substrate ends.

Opening does express the difference between the width at half depth and the with at 
substrate level. There can be selected the interpretation to be narrow or wide in the 
settings menu.

Crease depth = d
Half crease depth = d*50% = d’
Crease width = W
Crease opening narrow interpretation = o’-W
Crease opening wide interpretation = O-W

Section = A+B
Symmetry = B/(A+B)

The CREASE CHECKER PREMIUM Module offers additional measurements.
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CROSS SECTION MEASUREMENT

Measure the bead, turn the sample over to the opposite side and measure the 
spine of the same crease. The software displays the overlaid image.

Move the mouse pointer to first position in your crease 
(or bead).

Release the left mouse button. The analysis is displayed 
in terms of crease depth (or bead height and bead width).

Press the left mouse button down and keep it depressed.

Move the mouse pointer to the second position in your 
crease (or bead).

MANUAL MEASUREMENT OF BEAD AND CREASE

Click the right mouse button while the left mouse button 
is still depressed.

Move the mouse pointer with left mouse button still 
depressed to the bottom of the crease (or to the top 
of the bead respectively).



BOBST Preliminary user manual – V1.7.0.034

MEASURE EMBOSSING OR DEBOSSING ON LARGE AREAS

Select the embossing-debossing tool to measure embossing 
or debossing depth

Manual measurement of height differences:

Move the mouse pointer to the upper corner of the 
embossing area. A horizontal line is drawn when moving 
the mouse.

Release the left mouse button to obtain the 
measurement result.

Press the left mouse button down and keep it depressed.

Move the mouse pointer to the second level of your 
embossing area.
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Manual measurement of multiple height differences :

Move the mouse pointer to the upper corner of the 
embossing area. A horizontal line is drawn when moving 
the mouse.

Confirm the second level with a click on the right mouse 
button while the left mouse button is still depressed. 
The height difference is calculated and displayed in the 
main window.

Continue to insert levels with right mouse clicks until all 
height differences are calculated.

Release the left mouse button to obtain the average 
measurement result.

Press the left mouse button down and keep it depressed.

Move the mouse pointer to the second level of your 
embossing area.
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FINE STRUCTURED EMBOSSING OR DEBOSSING

In many cases the embossing and debossing is composed only by small lines or 
characters, such as there can be several embossed or debossed areas inside the 
captured image of the device.

Moreover the embossed or debossed areas are not necessarily uniform straight 
lines but they are composed of curves, lines are wider and smaller. This makes a 
simple edge height measurement impossible.

Version 1.5.0 of the software implements an additional tool to measure randomly 
height deviations due to embossing or debossing.

Position the aperture over the embossed or debossed icon, text, drawing. Make 
sure the embossed or debossed areas are quite visible inside the preview 
window. By slightly moving the device maximize the visible difference between 
surface and embossed or debossed area.

Press the measurement button on your device. The software will capture the image 
and automatically detect upper and lower areas. The software will automatically 
measure height deviations and calculate the maximum embossing or debossing. 
The maximum will be highlighted in red.
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This maximum embossing or debossing value is added to the table.

Measure on several locations and calculate the statistics:

In case of embossing (negative numbers) the MIN value is the most appropriate 
to control your manufacturing process. In case of debossing (positive numbers) 
the MAX value is the most appropriate to control your manufacturing process.

In general it is recommended to measure the inner side of the boxes to reduce 
the impact of print to the measurement results.

CAUTION: 
The calculation of embossing and debossing differs from the calculation of bead 
height and crease depth.

The bead and crease are assumed to have more or less round shapes. The height 
and depth therefore are calculated as the distance from the maximum peak to the 
surface of the material.

The embossing and debossing are assumed to have a flat surface on top or bottom 
of the line. The embossing and debossing are calculated as the Average depth or 
height of the center area.

As a result the embossing/debossing value is typically lower than the 
bead/crease value.

	 Bead	 Crease	 Debossing	 Embossing

The small numbers on top are representing the height difference between the 
actual surface and the average surface height (red line).

The physical depth of above example is -0.071mm and is calculated as the level 
difference between its neighbor’s height and the own depth:
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MEASURE EMBOSSING USING E-GUIDE

The E-GUIDE does support a 100% control of the embossed area.
 

CONFIGURE THE E-GUIDE

Position the box blank onto the table and fix it slightly with magnets. Take the 
CREASE CHECKER device out of the holder and move the holder down.

Move the box blank below the holder until the embossing area is well centered.

Move the holder to the starting point of the embossed area and fix the position 
with the screw.

Move the holder to the end point of the embossed area and fix the position 
with the screw.

Fix the box blank position with the magnets to easy position the next box blank 
on exactly the same place.

Insert the CREASE CHECKER into the holder.
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MEASURE EMBOSSING WITH E-GUIDE

•	 Position the box blank.
•	 Move the device to the start position.
•	 Press the measurement button to start the measurement process.  

Release the button.
•	 Wait until the traffic light gets green.
•	 Move the device over the box blank according to the bar on the screen
•	 The software automatically creates
	 – a 3D image based on 200 cross sections with 1280 measurements each
	 – and calculates the Embossing value as the average of the 10% highest  

(deepest) areas.

IMPORTANT: 
Don’t press down the CREASE CHECKER while pulling. Pull it without pressure to 
make sure you do not press flat the embossing area.

100% Embossing control – what does this mean
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FINISHED BOX CONTROL

Attach the angle tool accessory to the CREASE CHECKER device in order to have 
a 45° reference. Hold the finished box with one side parallel to the 45° plane of 
the Angle accessory.

Check the preview window and make sure the spine is visible inside the window. 
Please note that for higher measurement accuracy the vertical resolution of the 
image is higher than the horizontal resolution. Therefore a 90° opening angle will 
look like approximately 60°.

Press the button of the CREASE CHECKER to capture an image and to analyze the 
edge properties.

Bead width = length of line D.
Symmetry = line C:D intersection point position 
compared to the center point of line D.
Folding angle = real world angle between line A 
and B corrected for all projections.
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MEASURE THE FINISHED BOX WITH POWER BOX
 
POWER BOX offers additional measurement values

•	 Radius
•	 Roundness

The Radius can be pre-defined by inserting the value into the proper field.

If no value is inserted, then the radius will be calculated automatically as the 
radius of the circle that fits best between the two sides. Whenever a reference 
definition is selected the radius will be taken from the reference.

The roundness is the area difference between the perfect circle and the actual 
shape of the box (see green histogram in above example).
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Rounded corners are obtained by using multi crease technology. In this case 
several creases are produced with small distance between them. Select the 
number of creases in the settings Window.

Select 1 to let the software automatically determine the number of available 
creases or beads and their distances.

Position the CREASE CHECKER well centered on the multi crease and press the 
measurement button.

MULTI CREASE MEASUREMENTS

Bead height.

Single Bead distance.

The statistics displays the average bead height and the average distance.
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DAILY PRODUCTION QUALITY 
CONTROL OR CREASING

Enter the Job Identification number, select the standard you want to work with, and 
enter the name of the operator.

Start the measurement of a new box blank in production quality control by 
clicking the new job icon.

Click the OK Icon to continue.

Click the CANCEL Icon to abort.
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Measure as many type A locations as required. The Average and Standard Devia-
tion are calculated automatically.

Select B type measurements by clicking on the B on top of the table.

The Bead measurement function is selected automatically and the Job table 
appears in the Result Window.

If you would like to measure the crease, select Creases on blanks 
(CREASE CHECKER PREMIUM only).

If you would like to measure the Creasing counterparts select Creasing  
counterparts (BOBST version only).

Select A type measurements by clicking on the A on top of the table.

The basic version of the CREASE CHECKER software always shows just the standard 
box layout.

The PLUS Version of the software now displays the Box Layout that has been assig-
ned to the active reference containing all [A] measurement locations. Measurements 
of type [B],[C], and [D] are hidden.
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The PLUS version now displays the [B] locations. 

Measure as many type B locations as 
required. Average and Standard Devia-
tion are calculated automatically.

Continue by selecting C and D and measuring the proper creases. The PLUS version 
does support seven crease types. Use the scroll bar on bottom to scroll additional 
crease types into view.

Out-of-tolerance values are highlighted in red.
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Click this Icon to restart the measurement of the actual Box.

Start the measurement of a new box blank in production quality control  
by clicking the new job icon. Enter the Job Identification number, select the  
standard you want to work with, and enter the name of the operator.

Click delete to delete the most recent measurement.

Click the cancel Icon to exit without creating a report.

Click the OK Icon to create a report.

Click the save icon to save all measurement data into a tab 
delimited text file.

The procedure is the same for crease and Creasing counterparts.   
Only the measurement values obtained are as required.

DAILY PRODUCTION QUALITY CONTROL OF EMBOSSING 
(CREASE CHECKER PREMIUM)
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Proceed the same way you did for crease and bead measurements. Select the 
measurement position A..F and take readings. In case of Embossing or De-Bossing 
the maximum is collected.

If E-GUIDE is activated and the reference selected is an E-GUIDE embossing 
reference, then the E-GUIDE measurement data is collected in the table.
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Click this Icon to restart the measurement of the actual Box.

Click delete to delete the most recent measurement.

Click the cancel Icon to exit without creating a report.

Click the OK Icon to create a report.

Click the save icon to save all measurement data into a tab 
delimited text file.

Start the measurement of a new box blank in production quality control by clic-
king the new job icon. Enter the Job Identification number, select the standard 
you want to work with, and enter the name of the operator.

DAILY PRODUCTION QUALITY CONTROL OF FINISHED BOXES 
(CREASE CHECKER PREMIUM + POWER BOX REQUIRED)
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Click this Icon to restart the measurement of the actual Box.

Click delete to delete the most recent measurement.

Click the cancel Icon to exit without creating a report.

Click the OK Icon to create a report.

Click the save icon to save all measurement data into a tab 
delimited text file.

Measure the corners as requested by the software:
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Click the Statistics Icon to calculate the statistics. All selected jobs will be 
listed. The overall Average, the Standard Deviation, the maximum and the mini-
mum are calculated and displayed in a table. The measurement results of the 
selected quality reports will be displayed graphically.

Select the Standard from the list of available Standards.

Select the time frame by selecting the FROM date and the TO date appropriately.

Select the Job Identification number. You can select a specific job identification 
number to calculate a statistics over all measurements of this job. You can also 
use wild cards like ‘*’ to select similar job numbers.

Open Statistics on quality reports.

STATISTICS

Select the sample type (Card board bead, Creases on blanks, Embossing/Debossing).
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CREATE A JOB SUMMARY REPORT

Click the job summary Icon to create a summary report of the selected job.

SELECT AND DISPLAY A REPORT

Move the mouse pointer on one of the squares of one of the curves.
Click the left mouse button. The associated report will be displayed automatically 
and can be printed.
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DEVICE VERIFICATION
The CREASE CHECKER comes with the CREASE CHECKER target reference plaque 
that can be used for internal Device verification.

Open the Verification Tool by selecting the Verify Menu Item from the Device menu.

Type the reference numbers written on the reference plaque into the proper edit 
fields for bead and crease verification.

Position the device on the Bead side of the plaque and press the measurement 
button. Now rotate the plaque and measure the crease. If both measurements are 
in tolerance, you can create a PDF report and print the report using the PDF func-
tions on bottom.
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HIGH RESOLUTION VERIFICATION (PLUS VERSION ONLY)

The CREASE CHECKER STEP WEDGE can be acquired as an optional to perform 
high resolution verification of the CREASE CHECKER device. Based on a Look-Up 
table this feature can be used to match one CREASE CHECKER perfectly to another 
over years.

Open the high resolution function by selecting the ‘Verify Scale’ Item from the main 
menu ‘Device’.

Insert the reference values from the CREASE CHECKER STEP WEDGE label into 
the reference column of the table. Make sure to insert the lowest value on top. 
Click the SAVE Icon to save the reference values.

Click the CLEAR Icon to clear the table. Now start measuring each level starting 
with the lowest level. The absolute height will be displayed in blue color and the 
difference in red color in real time inside the graph.

In case the differences are out of tolerance you can calculate a LUT by clicking 
the LUT Icon. The LUT will be automatically stored and applied on all future 
measurements until a new LUT is created. The LUT does improve the inter instru-
ment Agreement of the devices.

Finally click the report Icon to create a calibration report.
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NOTE
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NOTE
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